
 

Continue

https://ggtraff.ru/wb?keyword=endnote%20styles%20scientific%20reports


Endnote styles scientific reports

The EndNote style gallery contains more than 4,500 bibliographic styles for different disciplines. If you don't want the style you want, go to the EndNote website. If you find the log style you want, download the file and save it to your desktop. For windows: left click on the Start menu, click explore, go to Program Files, click on EndNote,
click on the Folder Styles. Drag the output style file from the desktop to the folder. If you can't find the output style you want from the EndNote website, you can change the existing style that suits your needs. On the Edit menu, click Output Styles, and then click Open Style Manager. In the Style Manager, change the settings in the
dashboard (right) from Style Information to Style Preview. You should now see a preview of the selected style. Scroll through the list of available styles to see if you can find the style you want. When you find a similar style, select it and click Edit. The Style window opens. On the File menu, click Save As, give this copy of the style a new
name that matches the name of the journal for which you want to use it, and then click Save. This will also keep the original style unchanged, in case you need to use it later. The new style window remains open for editing as you need. There are many style elements that can be edited. For more information about the features of editing
styles, see the endnote guide (using the Help button). As an example, you can edit quotes in text from superscript 1 to author-year type. Click on Templates under the Citation heading to see the citation panel. This template tells EndNote to format text links. (The bibliography number corresponds to the numbered reference in the
bibliography.) The author style type will be displayed as (Author, Year) in the citation template. You can change the template by removing unwanted field names or punctuation marks by re-clicking the punctuation you want and pasting new fields using the Insert Field button. EndNote Output Styles FAQ Category: Tagged: EndNote Online
Login Buy Now EndNote offers over 6,000 bibliographic EndNote styles offering over 6,000 bibliographic styles Use below style search to find the style name and/or citation style and/or publisher. Install individual styles Download the style that you want to set. Double-click the style file. It should open in EndNote. In EndNote, go to the File
Menu and select Save As. Replace the word copy with the style name and click Save. Click the File menu and select Close Style. Have an X1 version or an earlier version? Click here for instructions. To set all styles or styles by The Mac OS: In EndNote category, go to Menu and select Customizer. Check next to all the output styles you
want. Double-click and Finish to close the window. Windows: Switch to Control Panel and select Add or Remove Programs in the XP or Programs and Features in Windows Vista/7. Click FinalNote, and then click Edit. Select Change option, and then select Next. Check next to More styles and select Install on local hard drive. Click the
plus sign to select only specific styles. Click Next. Learn more About EndNote Login Online Buy Now EndNote offers over 6,000 bibliographic style Guides Resources Citation styles This is a quick guide to how to format quotes and bibliography in a manuscript for scientific reports. For a complete guide to manuscript preparation, see the
journal's instructions to the authors. By using link management softwareTypically you do not format your quotes and bibliography manually. The easiest way is to use the help manager:PaperpileThen citation style is built in and you can select it in Settings &gt; Citation Style or Paperpile &gt; Citation Style in Google Docs.EndNoteFind style
here: review output stylesMendley, Zotero, Papers and otherStyle or embedded or you can download the CSL file, which is supported by most link management programs. Syles BibTeXBibTeX is usually part of the LaTeX template. Review the instructions for the authors if the publisher offers a LaTeX template for this magazine. Articles of
the journalThen examples are references to articles in scientific journals and how they should appear in your bibliography. Not all logs organize their published articles into volumes and questions, so these fields are optional. Some electronic logs do not provide a range of pages, but instead list the article ID. In this case, you can safely
use the article ID instead of the page range. Journal article with 1 authorNisbet, E. Earth Monitoring: Cinderella Science. Nature 450, 789–790 (2007). A journal article with 2 authorsTurechek, R. &amp; Trussell, L. O. Presynaptic glycine receptors enhance the release of the transmitter in the central synapse of mammals. Nature 411, 587–
590 (2001). A magazine article with 3 authorsCub, H., Ojci, Yu &amp; Ohmori, H. Pressnaptical activity regulates the distribution of Na(+) channels on the initial segment of the axon. Nature 465, 1075–1078 (2010). Journal article with 6 or more authorsSaito, T., Owen, D.M., Jiang, F., Marcotrijano, J. K. Rowling Nature 454, 523–527
(2008). Books and books are examples of references to author's and edited books, as well as book chapters. Cavalla, D. Off-label appointments - Justify unapproved medicine. (John Wiley &amp; Sons, Ltd, 2015). Perspectives in analysis: Essays to commemorate Lennart Carlson's 75th birthday. t. 27 (Springer, 2005). Section in edited
bookCorrin, L., Bennett, S. &amp; Lockyer, L. Digital Natives: Exploring the diversity of youth experience with technology. in reformatting learning: The boundaries of educational technologies in a global context (ed. Huang, R., Kinshuk &amp; Spector, J.M.) 113–138 2013). WebsitesSome links to websites should appear directly in the text,
not in the bibliography. Refer to the Instructions of the authors of scientific reports.Hamilton, K. What will the world actually look like at 1.5°C warming? 2016 IFLScience. Reports This example shows the overall structure used for government reports, technical reports and scientific reports. If you can't find the report number, it might be
better to cite the report as a workbook. For reports, these are usually not individuals who are enrolled as authors, but a government department or agency like the U.S. Food and Drug Administration or the National Cancer Institute. State Accountability Office. Problems in federal funding of school bus driver training programs. (1977).
Dissertations and dissertationsTheses, including PhD thesis, master's dissertations or bachelor's dissertations, follow the main format outlined below. Eldridge, R. L. Comparative quantitative study of college private audit behavior in a highly regulated environment. (NorthCentral University, 2012). News paper articlesUnknown scientific
journals, news articles usually do not have the volume and number of the question. Instead, the correct link requires a full date and page number. Pylon, M. Forging way to the starting line for younger disabled athletes. 2013- 2013. In the text of the quoteReferences should be given in the text consecutive numbers in the superscript: This
sentence provides one reference 1.This sentence provides two references 1,2.This sentence provides four references 1-4.Full name of the journalScientific reportsAbbreviationSci. Rep.ISSN (online)2045-2322ScopeMulti DisciplinaryOdner styles This guide describes how to prepare contributions for submission. We encourage you to read
this in full if you have not previously submitted a contribution to nature. We also recommend that you read Nature's style and content before submitting by reading the journal, either in print or online, especially if you haven't filed a journal recently. Nature Contribution Formats Articles are the main format for original contributions of nature
research. In addition, Nature publishes other materials presented as described below. Articles of the Articles are original reports, the conclusions of which represent a significant success in understanding an important problem and have immediate, far-reaching consequences. In print, they usually do not exceed 5 pages of Nature. Articles
begin with a fully referenced summary paragraph, ideally no more than 200 words, which is separated from the body text and avoids numbers, abbreviations, abbreviations or measurements if it is not important. It is aimed at readers outside of discipline. This summary paragraph must be structured as follows: 2-3 baseline sentences
entered into the field; a brief account of the background and the rationale for the work; statement of the main conclusions (introduced by the phrase Here we show or its equivalent); and finally 2-3 sentences that put the main findings into the general context, so it's clear how the results described in the article moved the field forward.
Please refer to our annotated example to see how the final paragraph should be constructed. The default length of an article with 3-4 modest display elements (pictures and tables) is 2,000-2,500 words (summary paragraph plus text). The modest element of the display is one that, with its legend, takes about a quarter of a page
(equivalent to ~270 words). A composite shape (with multiple panels) usually needs to occupy at least half of the page in order for all items to be visible - the length of the text may need to be reduced accordingly to place such shapes. Keep in mind that important, but technical details can be moved to methods or additional information. As
a reference point, articles tend to have 30-50 links, but remember the space they will occupy on the page. (There is no such limit on any additional links related to methods or additional file information.) Sections are separated by subtitles to help navigation. Subheadings can be up to 40 characters (including spaces). The number of words
refers to the text of the article. Links, title, author list and recognition should not be included in the total number of words. The issues arising and correcting the issues raised are exceptionally interesting or important comments and clarifications on original scientific papers or other peer-reviewed materials published in Nature. They are
published online, but not in print. For more information and instructions on how to submit such comments on peer-reviewed materials published in Nature - or to notify editors of the potential need for a fix - please refer to our Matters Arising page. Other contributions to Nature Please access other submitted pages of material for more
information about any of the types of contributions below: News and Comments Correspondence Obituary Thought Books &amp;amp; Art Futures News &amp;; Insights Views, Reviews and Perspectives Analysis Career Technology Hypothesis Features Perspectives Editorial Process See this section to explain nature's editorial criteria
for publishing, refereeing policies and how editors process documents after submission. Submissions to the journal Nature are authorized by the journal to mean that all of the listed authors have agreed all the content. See the authorship policy for more information. Requests for a preliminary commission If you wish to ask if your article
could be suitable for consideration by nature, please use our online request service for a preliminary commission. All requests for a preliminary commission must contain a cover paragraph to the editor stating interest in a wider scientific readership, in full summary paragraph and help list. Readability Nature is an international journal
covering all sciences. Contributions Contributions therefore to write clearly and simply so that they are available to readers in other disciplines and to readers for whom English is not their first language. Thus, technical jargon should be avoided as far as possible and clearly explain where its use is inevitable. Abbreviations, especially those
that are not standard, should also be kept to a minimum. The background, justifications and main findings of the study should be clearly explained. Names and theses in particular should be written in a language that will be easy intelligence for any scientist. Basic but specialized terms should be explained concisely, but not tactically. For
genes, proteins and other specialized names, authors can use their preferred terminology as long as it is in current community use, but they must give all known names to the entity when used for the first time in the newspaper. Nature prefers that authors use an internationally agreed nomenclature. Documents containing new or revised
formal taxonomic nomenclatures for animals, alive or extinct, are accepted conditionally on the provision of LSID (Life Science Identifiers) by registering such a nomenclature with ZooBank, a proposed online registration system for the International Code of Zoological Nomenclature (ICZN). Espite the fact that no paper will be rejected for
bad language, English speakers occasionally receive feedback from editors and reviewers about the use of language and grammar in their manuscripts. You may want to consider asking colleagues to read your manuscript and/or use a professional editing service such as those provided by our affiliates by the Nature Editing Service
research or experts at the American Journal. Note that using a language editing service is not a requirement to publish to Nature. Nature editors provide detailed advice on the format before contributions are officially accepted for publication. Nature editors often suggest reviewing titles and rewriting the final paragraphs of articles so that
the findings are understood by a wider readership. Once adopted, nature units (copywriters) ensure that text and numbers are readable and understandable to those outside the field and edit nature house-style documents. They pay special attention to the final paragraphs, general clarity, numbers, drawings of legends and names.
Evidence is sent for publication; the authors may discuss the proposed changes with Nature's subeditors, but Nature reserves the right to make a final decision on the style and size of the numbers. A useful set of articles providing general advice on writing and submitting scientific papers can be found in the section SciDev.Net How am I?.
The format of contributions of articles should be twice parted and written in English (writing, as in the Oxford English Dictionary) Contributions should be organized in sequence: title, authors, affiliation (plus addresses present), bold first paragraph, main paragraph main links, tables, tables, legends, methods (including individual data and
code availability statement), reference methods, recognition, author contributions, competing declaration of interests, additional information (containing additional information line (if any) and corresponding line of author), extended legends of data/table figures. In order to facilitate the review process, for initial submissions, we encourage
authors to include manuscript text and numbers together in a single file (Microsoft Word or PDF up to 30 MB). Shapes can be inserted into text in their respective positions or grouped at the end, and each legend of the picture must be represented along with its shape. Also, please include line numbers in the text. Titles do not exceed two
print lines. This is equal to 75 characters (including spaces). Names do not usually include numbers, abbreviations, abbreviations, or punctuation. They should include sufficient detail for indexing purposes, but be common enough for readers outside the box to appreciate what newspaper o. Text articles should fill in no more than 5 pages
of nature. The continuous text page contains about 1,300 words. The default article contains about 2,000-2,500 words of text and, moreover, 3-4 modest display elements (picture and/or tables) with short legends, a help list, and a method section, if possible. A composite shape (with multiple panels) should usually take about half a page
equivalent to approximately 600 words in order for all items to be visible (see section 5.9 for digit size instructions). When submitting new or revised manuscripts, the authors must include in the cover letter to the editor their rough assessment of the duration of their work in terms of word counting, as well as the estimated number of Nature
pages. Contributors who far exceed the limits specified here or specified by the editor will have to reduce their papers until accepted, inevitably delaying publication. Nature requires authors to specify the contribution made by their co-authors in the final notes of the article (see section 5.5). If the authors consider it necessary to specify that
two or more co-authors are equal in status, they can be identified by an asterisk character with the heading These authors have contributed the same to this work immediately below the address list. If more than three co-authors are equal in status, this should be stated in the contribution authors' statement. The present addresses appear
directly below the list of authors (below the footnote rule at the bottom of the first page) and can be identified by the dagger symbol; all other important explanations related to the author are in recognition. Our preferred format for text is Microsoft Word, with style tags removed. TeX/LaTeX: If you have prepared your paper with TeX/LaTeX,
we will need to convert this to Word after taking it before your paper is typed. All text material of the article (including links, tables, signatures, online methods, etc.) must be included as one .tex file. We prefer to use a standard font, preferably a 12-point Times New Roman. For mathematical symbols, Greek letters, and other special
characters, use plain text or symbol font. Use the Word/MathType Equation Editor only for formulas that cannot be created using plain text or symbol font. Methods The author must contain the Methods section at the end of the text, following the legends of the picture. This Methods section will appear in an online PDF and a full-text
(HTML) version of the paper online, but will not appear in the print release. The Methods section must be written as concisely as possible, but must contain all the elements necessary in order to allow interpretation and replication of the results. As a reference point, the Methods section does not usually exceed 3,000 words. To improve
reproducibility, the authors are encouraged to provide a detailed description of the protocols used in their study on the protocol exchange platform of their choice. Sharing nature protocols is a free and open service designed to help researchers share experimental know-how. The protocols provided by the authors in the exchange of
protocols will be related to the section Online methods after publication. Detailed descriptions of already published methods should be avoided; the reference number can be provided to save space, with any new addition or variation. The Methods section should be separated by short bold headlines referring to the methods used, and we
encourage the inclusion of specific units for statistics, reagents and animal models. If further links are included in this section, the numbering should continue from the end of the last reference number in the rest of the paper, and the list must accompany additional methods at the end of the paper. Please provide a separate statement
about data availability and code availability after major text statements and before legends of enhanced data; detailed instructions can be found in our data availability and data citation policy. Some types of data must be deposited in the relevant publicly structured data depository (details are available here), as well as the joining numbers
provided in the manuscript. Full access is required when publishing. If you need full access to your data for review, authors must provide it. Under Methods, you can't include pictures or tables (basic display items must be included in enhanced data). Link Links to each numbered, organized sequentially, when displayed in text, tables,
fields, picture legends, online methods, advanced data tables, and advanced data picture legends. If quoted in the text, the reference numbers are superscript rather than in parentheses unless they are likely to be confused with the superscript number. Do not use linked fields (manufactured by EndNote and similar applications). Please
use the one button Mouse provided by EndNote to remove EndNote codes before saving the file. File. Guidelines, articles allow up to 30 links in the main text, but can go up to 50 links if necessary and within the allocated budget page. For each number, you can take into account only one publication. The helplist should include only
articles that have been published or accepted by a named publication or uploaded to a recognized presint server (e.g. arXiv, bioRxiv); documents in preparation should be mentioned in the text with the list of authors (or initials, if one of the authors is the co-authors of this contribution). Published conference theses, numbered patents,
prepunts on recognized servers (prepunts of accepted works in the reference list must be presented with a manuscript) and research data sets to which the digital ID of the object was assigned may be included in the reference lists, but the text, details of the grant and recognition cannot be. (The exception is the highlighted links that we
ask the authors of reviews, perspectives and statistics articles to provide.) All authors should be included in the reference lists, unless there are more than five, in which case only the first author should be provided, and then others. Please follow the style below in the published edition of Nature when preparing help lists. First, authors
should consider the last name, and then the to whom and initials of the given names. The titles of all quoted articles are required. The names of the articles listed in help lists must be vertical, not text; the first word of the name with a capital letter, the name is written exactly as it appears in the quoted work, ending in full stop. Book titles
are talic with all capitalized basic words. Log names are italic and abbreviated according to general use. Volume numbers in bold. Publisher and city editions are required for the books mentioned. (See published articles in Nature for more information.) Research data sets can be listed in the reference list if they have been assigned digital
object IDs (DOI) and include authors, name, publisher (storage name), identifier (DOI expressed as URL). Example: Hao, Z., AghaKouchak, A., Nakhjiri, N. &amp; Farahmand, A. Global Integrated Drought Monitoring and Prediction System (GIDMaPS) data sets. 2014 (2014). In the list of links, you can provide recognized prepunts.
Example: Babichev, S.A., Rice, J. &amp; Lvivskyi, Quantum Scissors A.I.: teleportation of single-regional optical states using nonlocal single photon. Prepnt in (2002). Links to web logs must give authors, the title of the article and the journal name as above, followed by the URL in full - or DOI, if known - and the year of publication in
parentheses. Links to websites should give authors, if known, the name of the quoted page, the URL in full and the year of placement in parentheses. End notes End notes are short and follow the Methods. Confirmations should be brief and should not be included due to arbitrators and editors, inconsequentive words or quirky comments.
A person can be thanked for helping, not excellent help, or for comments rather than penetrating comments, for example. Thanksgivings may include grant numbers and contributions. Author Contributions: Authors must include a statement to indicate each co-author's contributions. The statement can be up to several sentences long,
describing the tasks of individual authors referenced by their initials. For more explanations and examples, see the authorship policy page. Statement on competing interests. More information: Authors must include a set of statements at the end of the article, in the following order: Articles containing additional information contain an
assertion: Additional information is available for this article. The sentence Correspondence and requests for materials must be addressed to the XX. Nature expects this identifiable author to respond to readers' requests and requests for materials, as well as coordinate the processing of any other issues arising from the published
contribution, including complaints about corrections. The author, named as the appropriate author, is not necessarily a senior author, and publishing the name of this author does not mean seniority. Authors may include more than one email address if it matters, in which case Nature will communicate with the first address for any
questions after publication arising and expect the author to coordinate with other co-authors. Review information includes the names of reviewers who agree to be quoted and completed by Nature employees during the inspection. A sentence labeled Reprints and permission information is www.nature.com/reprints. Life Sciences and
Behavioral and Social Science Reporting Guidelines To increase transparency in reporting and reproducibility of published results, life science authors and research articles of behavioral and social sciences must provide a completed reporting summary that will be available to editors and reviewers during the manuscript assessment. A
summary of the reporting will be published with all accepted manuscripts. Note that because of the advanced features used in these forms, you must use Adobe Reader to open and fill out documents. Recommendations and resources related to the use and reporting of statistics can be found here. Table tables must be presented on a
separate page, portrait (non-landscape) orientation, and vertically on the page, not sideways. Tables have a short header in one row in bold. Tables should be as small as possible. Keep in mind the size of the Nature page as a limiting factor when compiling a table. Symbols and abbreviations are defined directly below the table, and then
an important descriptive material as short as possible, all in two-point text. Standard table formats are available for views of cryo-EM, NMR and X-ray crystallography data. Authors who provide these you must use these standard tables to include as extended data tables. Legend Drawings For initial views, we encourage authors to include
manuscript text and numbers together in a single Word document or PDF, and for each shape legend to be presented along with its shape. However, if the paper is accepted, we demand that the picture legends be listed one by one, as part of a text document, separate from the picture files. Each picture legend must begin with a short
title for the entire shape and continue with a brief description of each panel and the characters used. For contributions to the sections of the methods, legends must not contain any details of methods or exceed 100 words (fewer than 500 words for all paper in total). In the Contributions sections without methods, legends must be less than
300 words (800 words or less in total). All the planks of the bum should be defined in the legend of the picture, as discussed above. Figures Nature require figures in electronic format. Please make sure that all digital images comply with nature magazines' policy on image integrity. The numbers should be as small and simple as they are
compatible with clarity. The goal is for the numbers to be clear to readers in other or related disciplines, and to help their understanding of the article. Unnecessary shapes and details (panels) of shapes should be avoided: data presented in small tables or bar charts, for example, can be briefly proclaimed in the text. Avoid excessive
complexity, painting and excessive detail. Drawings should not contain more than one panel unless the details are logically related; each multi-part shape panel must be the size so that the whole shape can be reduced by the same number and played on the printed page in the smallest size, which shows significant details. For guidance,
the standard dimensions of the Nature shape are 89 mm (one column) and 183 mm (double column), and the full page depth is 247 mm. Amino acid sequences must be printed in a Courier font (or other monospatial) using a single-lig code in rows of 50 or 100 characters. Authors describing chemical structures should use nature research
style guide chemical Structures. Some short instructions for preparing the figure: The inscriptions on the drawings (axis markings and so on) should be lowercase, with the first letter capitalized and without a complete stop. Units must have one space between number and unit and follow si nomenclature or nomenclature common for a
specific field. Thousands must be separated by commas (1,000). Unusual units or abbreviations are defined in legend. Scales should be used, not magnification factors. Layering type directly above shaded or textured areas and using reverse type (white text boxes on a colored background) should be avoided where possible. Where
possible, text, including character keys, should be provided in legend as well on the figure itself. Shape. Quality When initially presenting figures should be of high quality quality for evaluation by arbitrators, preferably included in the manuscript text in a single Word document or PDF, although the numbers can be supplied separately as
JPEGs if the authors are unable to include them in the text. Authors are encouraged to follow initial and revised guidelines on size, resolution and marking. Please note that the quality indicators of printed publications are great, and it is not helpful to download them at the submission stage. Even if they are uploaded to the nature



submission site, many arbitrators' institutions have email systems that will not accept large attachments. Authors will be asked about high-quality figures at the time of their article acceptance before publication, so it is not necessary to send them at the stage of submission. Third-party Nature rights prevent the use or adaptation of
previously published display elements (such as pictures, tables, images, videos, or text boxes). However, we recognize that some concepts require the use of published data and the reuse of previously published display elements. Please note that in these cases we will not be able to obtain the necessary rights to reuse some images (as
is or adapted versions) in our articles. In such cases, we will contact you to discuss finding alternative material. Drawing Costs In order to help cover some additional costs for four-color reproduction, Nature Research charges our authors a fee to print their colored figures. Please contact our offices for accurate pricing and details. Failure
to pay this fee will not prevent the publication of colored figures that editors judge to be important, but this must be agreed with the editor prior to adoption. Production and qualitative figures When the manuscript is received in principle for publication, the editor will ask for high-resolution figures. Don't send the publication quality figures
until the editor asks for it. At this point, please prepare the figures according to these guidelines. Advanced data Advanced data figures and tables online only (appear in online PDF and full-text HTML version of paper), peer-reviewed display elements that provide an important background of the article but are not included in the printed
version of the article due to space constraints or are of interest to only a few professionals. No more than ten elements of extended data (pictures and tables) are allowed. See the composition of the scientific work of nature. Advanced data tables should be formatted along similar rows to printed tables (see section 5.7), but the body text
(excluding the title and legend that should be included at the end of the Word file) should be presented separately as an image, not as a format for editing in Word, since the extended data tables are not edited by the subredsit department of nature. Small tables can also be included as a submene within the Data figures. Review the
advanced data formatting guide. Advanced data figures should be prepared along slightly different recommendations compared to printed drawings and can be multifunctional as long as they comply with size rules (see Advanced Data Formatting Guide). Advanced data figures are not edited or stylized by Nature's art department; for this
reason, the authors are asked to adhere to the style of nature as closely as possible in the preparation of these figures. Legends for extended shape data must be prepared both to print pictures and must be listed one by one at the end of a Word file. If space allows, Nature encourages authors to incorporate simple squematics like a panel
into the figure Advanced Data, which sums up the basic finding of an article where appropriate (e.g., to aid understanding complex details in cellular, structural and molecular biology disciplines). If the manuscript has extended numbers or data tables, the authors are asked to refer to discrete elements in the appropriate location in the main
text (for example, Advanced Data Fig. 1 and Advanced DataSheet 1). If further references are included in extended data tables and extended data picture legends, the numerage should be continued from the end of the last reference number in the main work (or from the last reference number under Advanced Methods, if any) and the list
should be added to the end of the list that accompanies the additional methods section if there is or is added under advanced data legends if there is no additional methods section. Additional Information Additional Information (SI) is only online, peer-reviewed material that is essential to the article (e.g. large data sets, methods,
calculations), but which is too large or impractical, or will interest only a few professionals to justify inclusion in the printed version of the article. See the More Information page for more information. Additional information should not contain numbers (any numbers additional to those appearing in print must be formatted as extended data
figures). Tables can be included in additional information, but only if they are unsuitable for formatting as advanced data tables (such as tables containing large data sets or raw data that works best for Excel files). If the manuscript accompanies SI, either when presenting or in response to an editor's letter requesting it, the authors are
asked to refer to discrete SI elements (e.g. video, tables) at the appropriate point in the main manuscript. Chemical structures and characteristics of chemical materials For guidelines describing nature standards for experimental methods and characteristics of new compounds, see the information sheet on the characteristics of chemical
materials. We aim to produce chemical structures in a consistent format throughout our article. Please use nature chemical structures guide ChemDraw template to That you are preparing your figures in a format that will require minimal changes to our artistic and production teams. Send the final files 100% as .cdx files. Submission All
contributions must be submitted online unless otherwise instructed by editors. Please be sure to read the information about what to include in the cover letter, as well as a few important issues related to the content when putting the submission together. All participants must agree to all nature publishing rules before applying. Nature
authors should make data and materials publicly available when publishing. This includes entering data into the relevant databases and organizing their public offering on the date of online publication (not after). A description of our initiative to increase transparency and reproduce published results can be found here. A full description of
Nature's publishing policy is on the website of nature's authors and arbitrators. Other Nature Research journals A story about the connection between all Nature journals is provided on the Family Nature page. Page.
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